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能無縫地置於錄音介面與喇叭之間。

如果你聽到的聲音不可信，那你的混音也就不可信。事實是，你的房間很可能正在拖累

你。向你介紹 ORIA Mini —— 一款房間校正的強大工具，它安裝在音訊介面與喇叭之間，
徹底改變你的監聽環境，立即提升表現。

我們與 Sonarworks 合作，帶來專用的硬體解決方案，只需幾分鐘就能分析並修正你的房

間聲學缺陷，讓你的工作室從「猜測與反覆確認」進化成可信賴的專業監聽環境。
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符合性宣告

FCC Part 15B
本設備已通過測試，並證實符合 FCC 規則第 15B 條所規範的 A 類數位裝置限制。
這些限制的設計是為了在住宅安裝環境中，提供合理的保護以避免有害干擾。

本設備會產生、使用並可能輻射射頻能量，若未依照說明書安裝及使用，可能會對無
線電通訊造成有害干擾。

若本設備確實對無線電或電視接收造成干擾（可透過開關設備來確認），建議使用者
嘗試以下一種或多種方式來排除干擾：

1.重新調整或移動接收天線。

2.增加設備與接收器之間的距離。

3.將設備連接到與接收器不同電路的插座上。

4.請洽詢經銷商或具經驗的無線電/電視技術人員以獲取協助。



IEC 62368 Test Report with Japan deviation.

We, Audient, declare that the product, ORIA Mini, to which this declaration 
relates, is in material conformity with the appropriate PSE standards and 
directives for an audio product designed for consumer use. METI Ordinance 
Appendix 12 J55032(H29).

We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
01256 381944, declare under our sole responsibility that the product ORIA
Mini complies with Part 15 of FCC Rules. 

Operation is subject to the following two conditions:

1. This device may not cause harmful interference,
2. This device must accept any interference received,

including interference that may cause undesired operation

We, Audient Ltd, declare that the product, the ORIA Mini, to which this 
declaration relates, is in material conformity with the appropriate CE 
standards and directives for an audio product designed for consumer use.

We, Audient Ltd, declare that the product, the ORIA Mini, to which this 
declaration relates, is in material conformity with the appropriate UKCA 
standards and directives for an audio product designed for consumer use.

Audient Ltd has conformed where applicable, to the European Union’s 
Directive EN 63000:2018 on Restrictions of Hazardous Substances (RoHS) as 
well as the following sections of California law which refer to RoHS, namely 
sections 25214.10, 25214.10.2, and 58012, Health and Safety Code; Section 
42475.2, Public Resources.

Under an environment with electrostatic discharge, the device may cease to 
output sound (EUT could not operate properly). This requires the user reset 
the device by unplugging & re-connecting to host computer. 

The unit may not operate as expected when there is radio interference on 
the power line. The unit will revert to normal operation after user reset.



安裝與設定



盒裝內容物

1 3

2

1 1 x ORIA Mini 

2

3 1 x USB C-C 線材

1 x Sonarworks (™) 測量麥克風 & 麥克風夾



初始設定
要開始使用 ORIA Mini，請將輸入來源與喇叭接上，並使用隨附的 USB 連接線將 ORIA 
Mini 連接至電腦。

輸入

你可以透過類比或數位連接將輸入來源（例如音訊介面或混音器）接入。若為類比來

源，請使用TRS輸入端子。若為數位來源，請使用光纖端子（S/PDIF）。接好後，你
可以在 ORIA Control 桌面軟體中選擇目前要使用的輸入來源。

輸出

ORIAMini提供線性輸出，用於連接一對立體聲喇叭及一個低音喇叭。這些輸出設計可
直接接入主動式錄音室間聽喇叭或功率擴大機。



Mac 安裝
前往https://audient.com/products/monitor-
controllers/oria-mini/downloads/ 
下載最新版本的ORIAControl桌面軟體。下載完成後，
打開 .dmg 檔案，然後將 ORIA Control 桌面軟體 拖曳
到應用程式資料夾中即可。

系統需求:
macOS 10.13.6 (High Sierra) or Later
Intel CPU or Apple Silicon
1GB RAM Minimum

Windows 安裝
前往https://audient.com/products/monitor-controllers/oria-mini/downloads/ 

下載最新版本的ORIA　Control桌面軟體後，打開.exe檔案。依照螢幕上的指示完成
安裝。此過程可能需要一些時間，請耐心等待。完成後，點選「完成 (Finish)」。

系統需求:
Windows 10 or Later
PC or Laptop manufactured after January 2006
Intel Core 2 @1.6Ghz, or AMD equivalent
1GB RAM Minimum

https://audient.com/products/monitor-controllers/oria-mini/downloads/ 
https://audient.com/products/monitor-controllers/oria-mini/downloads/ 
https://audient.com/products/monitor-controllers/oria-mini/downloads/ 


Audient ARC 註冊 
ORIA Mini 附帶一系列專業軟體與服務，提供你開始錄音所需的一切，來自業界領先
的創新者。前往 arc.audient.com，選擇「註冊您的產品 (Register Your Product)」，
並輸入個人資訊以建立帳號。

你將收到一封驗證電子郵件，請注意收件匣，也可能需要檢查垃圾郵件或廣告郵件

匣。

驗證帳號後，輸入 ORIA Mini 底部的序號與專屬四位數 PIN，即可完成 ORIA Mini 的
註冊。

完成註冊後，你即可從各種免費軟體與插件中選擇，立即取得強大的創作工具，輕鬆

展開你的錄音與混音工作。



韌體更新流程
Audient 偶爾會釋出 ORIA Mini 的新韌體，以增加功能並確保與作業系統更新的持續
相容性。

只要 ORIA Control 桌面軟體能連上網路，它會定期檢查是否有新的韌體更新，並在
有更新時通知你。

你也可以手動檢查韌體更新：點選 Help > Check for Updates。

若有可用的更新，ORIA Control 桌面軟體會通知你，點選 “OKAY” 即可開始韌體更新
流程。

接著，ORIAControl桌面軟體會啟動Audient韌體升級軟體。在該軟體中，你將看到目
前連接至電腦的所有Audient裝置清單。

請從清單中選擇 ORIA Mini。



你現在可以選擇從audient.com或本地檔案進行更新。

若你的電腦能連上網路，建議選擇 “From audient.com”，以確保安裝的是最新的韌體

版本。

若電腦無法連上網路，請聯絡support@audient.com，我們的團隊將提供最新韌體檔

案供你進行本地安裝。

接著，點選“Start　Upgrade”，進度條將開始顯示更新進度。在更新過程中，ORIA 
Mini裝置可能會重啟多次。

完成後，系統會跳出通知，確認韌體已成功安裝。

此時，你可以關閉 Audient 韌體升級視窗，並繼續使用 ORIA Mini。



硬體功能與連接



總覽



類比輸入 
ORIA Mini 提供兩組平衡 TRS 輸入端子，可接收來自音訊介面或其他線性輸入來源的音
訊訊號。ORIA　Mini也能接受非平衡訊號，例如來自CD播放器或手機的音訊。

請注意，ORIA　Mini的最大輸入電平為+18dBu。若你的介面最大輸出電平高於此值，請
確保音量已適當衰減，以避免訊號超載 (clipping) ORIA Mini 的輸入端。

數位輸入 
除了類比 TRS 輸入外，ORIA Mini 也可接收來自數位 S/PDIF 來源的立體聲音訊，使用光
纖 TOSlink 連接。

若你的訊號來源透過同軸輸出 S/PDIF，則需要使用同軸轉光纖的轉換器，此類轉換器在
網路上容易取得。

喇叭輸出 
ORIA Mini 提供三組平衡喇叭輸出：兩組用於立體聲左右聲道，一組用於低音喇叭。
喇叭輸出使用平衡 TRS 接頭；若需要非平衡連接，可直接插入 TS 接頭即可。

請注意，喇叭輸出為線性電平，設計用於驅動有源監聽喇叭。

若使用被動喇叭，需先將訊號送入適合的功率放大器，再接到喇叭。

若低音喇叭有左右分離輸入，請僅將 ORIA Mini 的 SUB 輸出連接到低音喇叭的 左聲道輸
入。



USB 連接 
ORIA Mini 配備 USB-C 端口，用於為裝置供電，並透過 ORIA Control 桌面軟體提供

遠端控制。

請注意，無法透過 USB 傳送音訊至 ORIA Mini，音訊必須透過類比或 S/PDIF 輸入端

送入。

USB 連接需使用 USB 3.0 或更新版本 的端口，能提供 5V @ 900mA 的總線電源。

或可使用外接 USB-C 電源供應器為 ORIA Mini 供電。

設定檔切換 
Profile 按鈕可在 ORIA Mini 上儲存的 前四個最愛設定檔之間快速切換，讓你依不同

工作環境或媒體類型迅速調整校正。

輕觸Profile按鈕即可在四個儲存的設定檔中循環切換。

若儲存的設定檔少於四個，則僅在已儲存的檔案間循環。

Profile按鈕亦可用於bypass　DSP或將裝置進入待機模式：

BypassDSP：長按Profile按鈕3秒，Profile　LED燈環會閃爍，表示DSP已被bypass。

待機模式：長按Profile按鈕6秒，即可將ORIA　Mini置於待機。

退出bypass或待機模式：輕觸 Profile 按鈕一次即可。

注意: 設定檔按鈕 (Profile Button) — 恢復出廠設定Profile 按鈕也可用來將 ORIA 
Mini 恢復到 出廠設定，此操作會清除所有儲存的設定檔。

操作步驟：

開機時按住 Profile 按鈕，直到 Profile LED 燈開始閃爍，然後放開按鈕。再次長按 
Profile 按鈕，此時所有 LED 燈會全亮，等到裝置完成清除內部快閃記憶體後，LED 
燈會熄滅，即表示恢復出廠設定完成。



訊號與峰值指示燈

這些指示燈用於顯示送入ORIA　Mini的大致訊號電平。

Signal指示燈：當適當的訊號電平送入ORIA　Mini的輸入端時會亮起。

若音訊已送入 ORIA Mini，但 Signal 指示燈未亮，可能是因為目前選擇的輸入來源錯誤
（類比或S/PDIF）。

若輸入來源正確，請確認提供訊號的裝置已正確連接。

Peak指示燈：若ORIA　Mini的輸入或輸出出現峰值，Peak指示燈會亮起。

輸入端峰值：請確保送入 ORIA Mini 的音訊裝置訊號不超過 +18dBu，若超過，需降低音
訊裝置的輸出電平。

輸出端峰值：可能是因極端校正 EQ 設定，對訊號施加大量增益所致。在一般聆聽環境
中，通常不需如此激烈的均衡調整。若必須對喇叭訊號施加極端均衡，建議嘗試其他解

決方案，例如調整喇叭位置或改善房間聲學處理。



軟體功能



　設定按鈕喇叭音量 　房間

電平顯示

喇叭群組控制

明亮/暗淡 模式

設定檔

    全域Bypass

　　喇叭按鈕 　系統按鈕輸入來源 　　監聽控制

總覽
ORIA Mini 的喇叭校正與其他設定皆由 ORIA Control 桌面軟體控制，提供你強大的操作介
面，方便直接管理校正設定與音訊路由。



設定檔
設定檔是 ORIA Mini 控制理念的核心。當你選擇一個設定檔時，即同時選擇了每個喇叭
聲道的校正參數——只需按下一個按鈕即可完成。

ORIA Mini 本身最多可儲存 32 個設定檔，而前面板的 Profile 按鈕 可快速切換你最喜愛
的 四個設定檔。

設定檔會儲存所有喇叭校正設定，包括每個聲道的 EQ 曲線、增益 (Trim)、延遲 (Delay) 
與分頻 (Crossover)。

你可以透過 ORIA Control 桌面軟體 手動建立新的設定檔，或從 Sonarworks™ SoundID 
Reference 應用程式匯入設定檔。

匯入 Sonarworks SoundID Reference 的設定檔需要 Sonarworks ORIA Mini Add-on 授
權。



建立新設定檔

要建立新設定檔，請點選 Profiles 面板右上角的「+」圖示。
為你的設定檔命名後，點選 “Save” 即可儲存。

複製現有設定檔

要複製現有的設定檔，請在 Profiles 面板中對設定檔名稱 點擊右鍵，然後選擇 
“Duplicate”。複製後的設定檔會顯示在原始設定檔下方。



重新命名設定檔

要重新命名設定檔，請在Profiles 面板中對設定檔名稱 點擊右鍵，然後選擇 “Rename”。
此時會出現游標，允許你編輯文字。輸入新名稱後，按下 Enter 即可完成。

刪除設定檔

要刪除設定檔，請在 Profiles 面板中對設定檔名稱 點擊右鍵，然後選擇 “Delete”。
系統會跳出確認視窗，要求你確認是否刪除。



設定檔管理

設定檔清單分成兩個區塊：

最愛 (Favourite) 設定檔：位於分隔線上方，共四個，每個都有編號。這四個可以透過 
ORIA　Mini機身前方的Profile按鈕來切換。

非最愛(Non-Favourite)設定檔：位於分隔線下方。

你可以隨時調整設定檔的順序，只需要用滑鼠左鍵按住要移動的設定檔，然後拖曳到想

要的位置即可。重新排序的邏輯如下：

最愛→最愛：兩個設定檔會交換位置。

最愛 → 非最愛：該最愛設定檔會移到指定位置，而最上方的非最愛設定檔會被移到「最
愛」區塊。

非最愛→非最愛：該設定檔會放到指定位置，其下方的設定檔會依序往下移。

非最愛 → 最愛：該非最愛設定檔會取代原本的最愛位置，而被取代的最愛設定檔會移到
非最愛清單的最上方，其他依序往下移。

選擇設定檔

要啟用某個設定檔，只要在清單中點擊它即可，該設定檔會變成目前的 使用中設定檔。
使用中的設定檔會以 白色文字顯示，其他未使用的則會顯示為 灰色文字。

此外，你也可以透過 ORIA Mini 機身前方的 Profile 按鈕，點擊來循環切換四個「最愛」
設定檔。



修改設定檔

如果你在啟用中的設定檔上做了任何變更，啟用中的設定檔名稱旁邊會出現一個小圖

示。這代表目前所做的變更尚未儲存到該設定檔中。

要儲存變更，只需點擊 儲存圖示。稍等片刻後，變更就會完成儲存，並顯示一個 綠色勾
勾圖示，代表操作已完成。

如果你在未儲存變更的情況下嘗試切換到其他設定檔，或是關閉 ORIA Control 桌面軟
體，系統會跳出對話框，詢問你是否要：將變更儲存到目前的使用中設定檔，建立一個

新的設定檔，或放棄變更。



匯入與匯出設定檔

ORIA Control 桌面軟體允許你匯出手動建立的設定檔，以便備份或與其他使用者分享。
此外，你也可以從外部檔案匯入 Sonarworks 或 ORIA Mini 自訂設定檔。

匯出自訂設定檔

若要匯出目前啟用的自訂設定檔，請至選單列並點選 檔案 > 匯出自訂設定檔。

你也可以在 設定檔清單 中，對著想要匯出的設定檔點擊右鍵，然後選擇 「匯出」。

現在，為設定檔命名，並選擇要將設定檔檔案匯出的資料夾位置。點選 「Save」，設定
檔就會被匯出。

匯入自訂設定檔

要匯入自訂設定檔，請至選單列，點選 檔案 > 匯入自訂設定檔 (File > Import Custom 
Profile)。

此時會開啟 Finder（Mac）或 檔案總管（Windows），可讓你選取先前儲存的設定檔。
選擇檔案後，點選 「Open」。

接下來的畫面可讓你依需求重新命名設定檔，並選擇是 建立新的設定檔 還是 覆蓋現有
的設定檔。



建立新設定檔 - 選擇 「建立新設定檔」 將會把設定檔加入到 ORIA Control 桌面軟體左
側的設定檔清單中。請注意，最多可儲存 32 個設定檔。若所有位置已滿，「建立新設定
檔」選項將呈現灰色，你需要 覆蓋現有設定檔 或 放棄變更。

覆蓋現有設定檔 -選擇 「覆蓋現有設定檔」 後，可選擇要覆蓋的設定檔。

從設定檔清單中選擇一個設定檔，點選 「OK」，系統會跳出確認畫面，確認你是否確定
要覆蓋該設定檔。

請注意，一旦設定檔被覆蓋，無法復原。

若你想回到上一個畫面，請點選 「Back」；或選擇 「Cancel」 以完全中止匯入操作。



你可以從以下 輸入來源 中進行選擇：

- Line
- S/PDIF

請注意，輸入來源 (Input Source) 的選擇不會儲存在設定檔中。
若要更換音訊來源，需要 單獨手動切換。

手動匯入 SoundID 設定檔

要手動匯入 Sonarworks SoundID 設定檔，請至選單列，點選 檔案 > 匯入 SoundID 設
定檔(File>ImportSoundIDProfile)。

此時會開啟 Finder（Mac）或 檔案總管（Windows），可讓你選取在 Sonarworks 
SoundID　Reference軟體中建立的SoundID設定檔。

選擇檔案後，點選「Open」。與匯入自訂設定檔相同，你可以選擇 建立新的設定檔 或 
覆蓋現有設定檔。

輸入來源



喇叭音量
你可以透過 點擊並拖曳喇叭音量控制 來調整喇叭音量。

若使用外部裝置的音量控制來調整監聽音量，Audient 建議將 ORIA Mini 的喇叭音量設
定為 0dB。

DIM：將整體音量降低指定的幅度。

降幅可在 ORIA Control 桌面軟體的 System Panel中調整。

Mono：將左右聲道合併為單聲道，用於檢查單聲道相容性。

Polarity：翻轉左聲道相位，並將輸出合併為單聲道 (MONO)。

監聽控制
為了輔助監聽，ORIA Mini 提供 4 種監聽控制 
(Monitor Controls)：

靜音 (Mute, M)：靜音所有喇叭輸出。



亮色/暗色模式 
ORIA Control 桌面軟體可依個人喜好與工作室環境，切換 亮色模式 或 暗色模式。

喇叭按鈕
當 System Panel 開啟時，按下 Speakers Button 可快
速返回 預設的房間視圖 (Room View)。 

Global Bypass
此功能可Bypass ORIA Control 桌面軟體中的 所有 
EQ、聲道增益 (Channel Trim) 與延遲 (Delay) 設定。
請注意，此功能不會Bypass分音器控制(Crossover 
Controls)。

暗色模式切換 亮色模式切換



PRE
顯示從你的輸入來源送入 ORIA Mini 的訊號。PRE 為預設選項。

POST
顯示經過 ORIA Mini 輸出 DSP 處理後，送往喇叭的訊號。在 POST 電平顯示模式下，會
考慮喇叭音量控制的影響。

SUB
當處於 PRE 電平顯示模式時，Sub 聲道的電平不會顯示，因為在 ORIA Mini 的 DSP 
中，分頻器作用前並沒有SUB訊號。

當處於 POST 電平顯示模式時，Sub 電平會顯示經過分頻器後送往 SUB 聲道的音訊。

電平顯示
ORIA Control 桌面軟體提供簡單易用的電平顯示功能，可讓你快速檢查音量、輸出路
由，以及ORIA　Mini　DSP的影響。電平顯示的設定完全獨立於設定檔，因此在切換設
定檔時不會改變。



擴展電平顯示面板

點擊 擴展圖示 (expand icon)，可將 電平顯示面板 展開為獨立視窗，讓你在混音時將電
平顯示保持在前景。擴展的電平顯示視窗會顯示更多細節，例如 dBFS 刻度 和 峰值 
(Peak) 數值。

設定按鈕
Setup Button 允許你手動編輯每個輸出的校正設定。在 Room 區域 中點擊任一喇叭圖示，
即可查看該喇叭輸出的各種選項。

當某個喇叭正在編輯時，該喇叭周圍會出現 光環 (halo) 以示標示。

請注意：從 Sonarworks SoundID Reference 匯入設定檔時，該設定檔的 EQ 控制鎖
定，無法直接在ORIA　Mini上修改。若要更改EQ曲線，應先在SoundID　Reference 
中調整，然後再重新匯入設定檔。



喇叭設定

顯示目前正在調整的聲道名稱。

Mute (M) - 可靜音選取的單一喇叭。在 Setup Mode 下，也可按鍵盤 ‘M’ 鍵靜音該聲
道。

Solo (S) - 可單獨監聽選取的喇叭。在 Setup Mode 下，也可按鍵盤 ‘S’ 鍵將該聲道 
Solo。

Copy/Paste-若想將相同設定套用到其他喇叭，點選Copy按鈕複製設定。

接著選擇另一個聲道，點選Paste按鈕即可將複製的設定套用到該聲道。

也可將 DSP 設定貼上至 喇叭群組 (Speaker Group)，以將相同設定套用到該群組的所有
喇叭。在Groups　Panel中對喇叭群組右鍵點擊，選擇Paste即可。請注意，僅EQ與分
頻(Crossover)DSP設定會被貼上至群組。Trim 與 Delay 值 應該依單一喇叭設定，以確保
喇叭系統的時間對齊正確。

Reset-點選Reset按鈕可將該聲道回復至預設設定。系統會跳出確認對話框，避免設定被
意外重置。



EQ

當建立手動設定檔時，每個聲道預設會提供 8 個 EQ 點（6 個參數化頻段、1 個低頻架 
(Low Shelf) 與 1 個高頻架 (High Shelf)），用來調整該喇叭輸出的校正。不過，你也可以 

移除部分頻段，讓圖表更清楚，而不必使用全部 8 個 EQ 點。

在Channel　Setup視窗中，透過+與-圖示來新增或移除EQ頻段。點擊+按鈕會在圖表上
1kHz位置新增一個EQ點。新增後，你可以輸入該頻段的 頻率 (Frequency)、Q 值 與 
±dB，或直接在圖表上手動拖曳EQ點調整。

點擊 - 按鈕可移除圖表上 目前選取的 EQ 點。

左右頻段箭頭 (Left and Right Band Arrows)：可在圖表上顯示的 EQ 頻段間切換，選擇
當前要編輯的 EQ 頻段。

你也可以使用鍵盤的左右方向鍵在EQ頻段之間切換。若設定出現錯誤，軟體提供 
Undo（復原） 與 Redo（重做） 按鈕以便修正。

Bypass EQ B按鈕 (Bypass EQ Button) 允許你關閉此聲道的 EQ 功能。

請注意：Sonarworks 設定檔 提供 18 個 EQ 頻段，可進行更高解析度的校正。



輸出控制

在此區域，你可以控制每個輸出的各種選項。在 Setup Panel 的下方，還有三個用於喇叭校
正的額外控制項。

Trim 第一個控制項是 Trim，可將該喇叭的音量 提升或降低最多 12dB，步進為 0.1dB。
可點擊並拖曳控制項來增加或減少Trim。或 雙擊 控制項，手動輸入數值。

Delay　第二個控制項是Delay，可延遲該喇叭的訊號時間。這有助於對齊各喇叭訊號，使
聲音同時到達聆聽者，以達到最佳音像定位。

Delay範圍為0毫秒至75毫秒，步進為0.01毫秒。

可點擊並拖曳 控制項調整延遲，或 雙擊 輸入數值。Delay 控制另有 On/Off 按鈕，可開啟
或關閉延遲。

Crossover　第三個控制項是Crossover，用於低頻管理(Bass　Management)。

點擊On/Off按鈕啟用後，該喇叭的低頻管理將生效。

意即所有低於控制項設定頻率的訊號將 從此喇叭路徑移除，並重新導向 低音喇叭 (SUB) 路
徑。

SUB 聲道 不顯示分頻控制，因為對 SUB 聲道不需要此功能。



設定檔設定

Profile Setup 分頁包含適用於 整個設定檔 的設定，而不僅限於單一喇叭聲道。

喇叭設定檔 - Speaker Profile Trim 允許你為 目前啟用的設定檔 指定音量調整，以便匹
配不同設定檔之間的音量，避免切換設定檔時出現音量跳動。可調整範圍為 ±12dB。



房間
本區域提供喇叭配置的視覺化顯示。

白色USER圖示：表示聆聽者面向的方向。

喇叭圖示的顏色：表示該喇叭所屬的 喇叭群組 (Speaker Group)。
• FRONTS = Dark Purple
• SUBS = Green

當喇叭正在接收音訊時，該喇叭上會出現一個小型波形圖示。

這在設定或安裝過程中，非常有助於辨識 哪個喇叭正在輸出音訊。



單聲道 與 靜音
在 Room 中的喇叭，可以使用以下 鍵盤快速鍵 進行 Solo 或靜音操作：

• Mute - 滑鼠左鍵

當喇叭被靜音，或因其他喇叭處於 Solo 狀態而未啟用時，該喇叭圖示會呈 灰色。

當某個喇叭被 Solo 時，Mute 功能 對其他所有喇叭和群組將無法使用，但使用者仍可繼
續對 Room 中的其他喇叭進行 Solo 操作。

被 Solo 的喇叭，其對應的電平表會在 Post 電平顯示視窗中保持啟用。

清除 Solo/Mute 狀態 可以使用以下快速鍵：

• Option (MacOS) / Alt (Windows) +　滑鼠左鍵

點擊 已 Solo 的喇叭 將會清除所有啟用的 Solo 狀態；
若點擊 已靜音的喇叭，則會清除所有啟用的靜音 (Mute) 狀態。

• Solo - Shift +滑鼠左鍵



喇叭群組控制
此監聽功能允許你 分別靜音 (Mute) 或 Solo 立體聲喇叭與低音喇叭 (Sub Speakers)。

當 單一喇叭 或 喇叭群組 被靜音時，它們會在 Room 視窗 中呈現 灰色。

同樣地，若某個或多個 喇叭群組被 Solo，其他所有群組在 Room 視窗 中也會呈現 灰色。



系統面板
位於 ORIA Control 桌面軟體 上方的 System Panel 按鈕，可讓你檢視 進階的連接與控制設
定。System　Panel分為兩個頁面，可透過左側的分頁標籤進行切換。

一般 (General)

DIM Trim
在此可調整 啟用 DIM 功能時的音量降低幅度。

Crossover Attenuation
此控制可對經 分音器 (Crossover) 發送至 Sub 聲道 的訊號套用 全域衰減。
可設定的衰減範圍為 0dB 至 -10dB。

Global Delay
此功能可對 ORIA Mini 的所有輸出訊號 套用時間延遲，方便將音訊與影片同步。



設定

當裝置（例如運行 ORIA Control iPad App 的 iPad）嘗試連接 ORIA Mini 時，你可以選
擇以下操作：接受 (Accept)　拒絕 (Deny)　封鎖 (Block)

遠端控制

Remote 頁面 可讓你設定哪些裝置可以對 ORIA Mini 進行遠端控制。

更多關於透過 ORIA Control iPad App 及 Stream Deck 整合 的遠端控制資訊，請參考
本手冊的 遠端控制 (Remotes) 章節。



如果你 接受 (Accept) 該連線請求，裝置將會被加入 系統面板 (System Panel) 的 
Remote頁面中的「已批准裝置清單(Approved　Devices)」。

任何已批准的裝置，在同一網路下使用時，會自動連接到ORIA　Mini。
當裝置成功連接 ORIA Mini 時，該裝置旁會顯示 綠色勾勾圖示。

如果 封鎖 (Block) 該連線請求，裝置將 無法連接 ORIA Mini，且之後也無法再次發出連
線請求。

這在擁有多台 ORIA Mini 的環境，或在教育機構中希望限制遠端存取僅限已批准裝置時
非常有用。被封鎖的裝置會被加入 Blocked Device 清單，方便你查看哪些裝置已被封
鎖。

移除已批准的裝置

若想從 Approved Devices 清單 中移除裝置，點擊該裝置旁的 ‘i’ 圖示。
系統會跳出確認視窗，詢問是否確定要 「忘記 (Forget)」 這個裝置。

解除封鎖裝置

同樣地，若想從 Blocked Devices 清單 移除裝置，點擊該裝置旁的 ‘i’ 圖示。
系統會跳出確認視窗，詢問是否確定要 解除封鎖 (Unblock)。

解除封鎖後，該裝置即可再次發出連線請求。



輸出校正

為了正確校正你的監聽喇叭以符合聆聽環境，必須對空間進行 高品質測量。隨附的

Sonarworks測量麥克風可用於此目的。

注意：ORIA Mini 本身 沒有麥克風輸入。建議使用提供訊號給 ORIA Mini 的 音訊介面 
(Audio　Interface)上的麥克風輸入。

如果你的音訊介面沒有麥克風輸入，則需找到其他方式連接麥克風以完成測量。

Sonarworks SoundID Reference 

與 Sonarworks 的緊密整合可讓你 輕鬆將校正設定匯入 ORIA Mini 內建 DSP，在不增
加電腦 CPU 負擔的情況下套用喇叭校正。

Sonarworks Licenses

要在ORIA　Mini上使用SoundID　Reference，你需要：

有效的SoundID　Reference授權Sonarworks　ORIA　Mini　Add-on套件

ORIA　Mini可含或不含SoundID　Reference授權購買。

若購買時不含授權，可向當地經銷商或直接在Sonarworks官方網站購買。

ORIA　Mini　Add-on　License　Bundle可將校正匯入單一ORIA　Mini裝置。

當校正首次從 SoundID Reference 匯入 ORIA Mini 時，該單位的 序號 (Serial Number) 
將被紀錄，並與你的Sonarworks帳號關聯。

若希望將校正匯入多台 ORIA Mini，例如在多工作室環境中，則每台裝置都需購買 獨立
的 ORIA Mini Add-on License。



測量流程

Sonarworks 測量流程 非常簡單明瞭，每個步驟都會有指引，確保你能 取得準確的測量
結果。

使用的 分頻頻率 (Crossover Frequency) 取決於你喇叭與低音喇叭的 頻率響應特性。

如果不確定應使用哪個分頻頻率，建議聯絡喇叭/低音喇叭製造商尋求建議。

若在測量完成後調整分頻頻率，會影響校正結果，因此需要重新測量。

因此，我們建議 在進行首次測量前，先確認分頻頻率已正確設定。

你可以在此找到完整的流程說明。

若使用 低音喇叭 (Subwoofer)，在 SoundID Reference 進行測量前，務必先在 ORIA 
Control 桌面軟體 中設定 分頻頻率 (Crossover Frequency)，以確保立體聲測量結果的準
確性。

設定分頻頻率的方法如下：

在ORIA　Control桌面軟體的Room區域，選擇左聲道或右聲道喇叭。點擊 Setup 按鈕。
在 Setup 面板右下方的控制項中調整 分頻頻率。



將校正匯入 ORIA Mini

完成測量後，可將結果匯入 SoundID Reference。在 SoundID Reference 中，你可以建
立 校正設定檔 (Calibration Profiles)，並將其上傳到 ORIA Mini 硬體。

操作步驟如下：

在 SoundID Reference 軟體中，點擊 Export Preset to Device。
從裝置清單中選擇 ORIA Mini。

首先，你可以在匯出校正設定前調整校正曲線。

可新增 EQ 曲線以符合你正在處理的內容，例如 Dolby Film Curve、Dolby Music Curve 或
其他類似設定。也可以自行進行自訂調整。

若ORIA　Mini已連接到電腦，可直接將校正設定傳送至ORIA　Mini。若未連接，則可匯出 
參數檔 (Parameter File)，之後再透過 ORIA Control 桌面軟體 將其匯入 ORIA Mini。

注意：首次將校正設定傳送至ORIA　Mini必須在裝置連接的情況下進行。這是為了讓 ORIA Mini 的 序號 
(Serial　Number)能被讀取，並與你的Sonarworks帳號關聯。之後的匯出則可以 直接傳送 或匯出為 參數
檔 (Parameter File)。



新的設定檔(Profile)現在會出現在Profile面板中。

注意：由 SoundID Reference 建立的設定檔，其名稱旁會顯示 Sonarworks 的 “S” 標
誌。

直接匯入

若選擇 Direct Transfer to ORIA Mini，ORIA Control 桌面軟體 會被切換到前景，並詢
問你是否要建立新設定檔(Profile)或覆蓋現有設定檔。

若建立新設定檔，系統會提示你輸入設定檔名稱。

若選擇 覆蓋現有設定檔，系統會讓你選擇可被覆蓋的設定檔。



透過參數檔匯入

若你匯出了參數檔 (Parameter File)，可以透過以下方式將其匯入 ORIA Mini：

開啟ORIA　Control桌面軟體。

在選單中點擊File>Import　SoundID　Profile。

系統會開啟Finder或File　Explorer視窗，讓你選擇匯入的檔案。

如同直接傳送 (Direct Transfer)，你可以選擇 建立新設定檔 或 覆蓋現有設定檔。

注意：在ORIA　Mini中使用SoundID　Profiles時，應關閉或停用SoundID 
Reference　軟體。
否則音訊可能會被重複處理，導致 校正結果不準確。



請注意：ORIA Mini 加購授權（數位金鑰） 已包含在 ORIA Mini + SoundID Reference 
Complete Bundle 以及 ORIA Mini + SoundID Reference Add-On Bundle 中。如果您認為
自己已經擁有授權，請聯絡 Sonarworks 客服團隊。

無法讀取序號

要將校正檔（Profile）匯出至 ORIA Mini，SoundID Reference 需要讀取您 ORIA Mini 的序
號（Serial Number）。如果序號無法讀取，系統將顯示錯誤訊息。

Sonarworks SoundID Reference 
故障排除

需要ORIA Mini Add-on 授權

已擁有 SoundID Reference 的使用者，可向 Sonarworks 購買單獨的「加購數位授權金鑰
（Add-on License Key）」，以便將校正檔（Calibration Profiles）直接匯出到 ORIA Mini 
硬體。

如果您在沒有有效 ORIA Mini 加購授權（數位金鑰）的情況下，嘗試從 SoundID Reference 
匯出校正檔到 ORIA Mini，系統將提示您必須先購買授權才能繼續匯出。



為了解決此問題，請確認 ORIA Mini 的 USB 線已牢固連接到電腦，然後點選重試
（Retry）。

如果問題仍然存在，請嘗試使用其他 USB 埠或更換 USB 線。若問題依舊，請聯絡 Audient 
客服團隊。

無法匯出 2.1 校正檔

請注意，若使用 SoundID Reference 進行多聲道（Multichannel）校正，無法將 2.1 測量檔
匯出到 ORIA Mini。交叉頻率（Crossover）設定與低音單體（Sub）校正需手動調整。



• EQ (up to 8 bands, 6x ±12dB, 20Hz - 20kHz + Hi-shelf and Lo-shelf)
• Output Trim (±6dB)
• Delay Time (0-75ms)
• Crossover Point (30Hz - 500Hz)

手動校正
如果您不想使用 SoundID Reference，也可以改用第三方測量軟體進行校正。可使用隨附的 
Sonarworks測量麥克風，或依喜好使用您自己的參考麥克風。

若使用第三方軟體，無法將設定直接匯入 ORIA Mini，揚聲器的校正設定必須手動輸入。第
三方軟體通常會提供可套用到每個聲道的 EQ 曲線，以及 Trim 與 Delay 設定。

這些設定可依照本手冊「設定選單（Setup Menu）」章節的說明，手動輸入到每個聲道。
在手動校正時，您可以調整每個喇叭聲道的以下參數：



控制器



ORIA Remote iPad App
使用 ORIA Mini 的 iPad App，讓您掌握每一個細節。觸控操作即可遠端控制 ORIA 
Mini的所有功能，集中於一個控制中心。

您可以直接從桌面調整音量、測試喇叭、切換校正檔（Profiles）以及監控量測表

（Metering）。精準控制，操作簡單，免除繁複設定。

                     可在 Apple App Store 免費下載

https://apps.apple.com/us/app/oria-remote/id6498923078
https://apps.apple.com/us/app/oria-remote/id6498923078


初始設定

將 ORIA Mini 透過 USB 連接到電腦，並啟動 ORIA Desktop Software 後，即可準備使
用 ORIA Remote iPad App，以觸控方式完整操作 ORIA Mini。

首先，打開 Apple App Store，搜尋 ORIA Remote，並安裝到您的裝置上。
開啟 App 後，系統會提供一個簡短的導覽，讓您熟悉應用程式的各項功能。

在此過程中，系統會要求您為 iPad 命名，這個名稱將會顯示在 ORIA Control Desktop 
Software中。您也需要允許 ORIA Remote iPad App 在本地網路中搜尋並連接裝置。

請注意，即使您的 ORIA Mini 主機電腦是透過網路（Ethernet） 連接而非 Wi-
Fi，ORIA Remote iPad App 仍可連線使用，只要所有裝置仍連接在同一個網路中即
可。



接著，您需要依照本手冊「遠端控制（Remotes）」章節的指示，在ORIA　Control 
Desktop　Software上允許此連線。連線獲准後，系統會顯示 「成功連線（Successfully 
Connected）」訊息。此時，您即可開始使用 ORIA Remote iPad App 來控制 ORIA 
Mini。



應用程式概覽
連線成功後，ORIA Remote iPad App 提供多個頁面，可用來控制 ORIA Mini 硬體的不
同功能。您可以透過左側側邊選單（Sidebar　Menu）的圖示在各頁面之間切換。
以下為各頁面的簡要介紹：

主頁是 ORIA Remote iPad App 的主要頁面，提供 ORIA Mini 所有主要控制功能的概
覽。這些功能的快速介紹可參考下一頁。

主頁 -

　校正檔選擇

　　監聽區域

　　輸出量表　群組靜音與單獨監聽



校正檔選擇

在此可選擇您在 ORIA Control Desktop Software 中建立的各種校正檔。只需點選某個校
正檔，即可將其設為目前的 「啟用校正檔（Active Profile）」。

群組靜音與單獨監聽

這些控制項可讓您靜音立體聲（Stereo）或低音（Sub）聲道，或單獨監聽（Solo）立體
聲聲道。

輸出量測

量測表會顯示 ORIA Mini 輸出端的目前訊號電平。您也可以點選標題旁的 展開圖示
（expand icon），將量測表放大以查看更高解析度的訊號資訊。

監聽區域

監聽區域主要包含三個控制：輸入來源（Input Source）、主音量控制（Main Volume 
Control）以及監聽控制（Monitor Controls）。

輸入來源

在此可選擇 ORIA Mini 的音訊來源，支援 Line 或 S/PDIF 輸入。

主音量控制

控制 ORIA Mini 輸出到喇叭的總音量。
為避免音量被意外調整，該控制項預設為 鎖定。點選即可解鎖，調整音量後，點選螢幕
其他區域，音量控制會自動再次鎖定。

此自動鎖定功能可在設定選單中開啟或關閉。

監聽控制

可使用 ORIA Mini 的全域監聽控制，包括 靜音（Mute）、單聲道（Mono）、降音
（Dim） 和 相位（Phase）。

更多關於這些控制的資訊，請參考本手冊 ORIA Control Desktop Software 的監聽章節。



校正檔選擇

此區與主頁（Home Page）中的 校正檔選擇 區域相同，可用來切換已建立的校正檔。

群組靜音與單獨監聽

此區與主頁（Home Page）中的 群組靜音與單獨監聽 區域相同，可控制靜音或單獨監
聽立體聲及低音聲道。

房間頁面提供每個喇叭的獨立控制，並以視覺化方式呈現您的喇叭配置。

　校正檔選擇

　群組靜音與單獨監聽

　　房間選擇

房間 -



房間

此區可輕鬆對ORIA　Mini的各個喇叭輸出進行靜音或單獨監聽。

點選某個喇叭圖示即可靜音（Mute）該輸出，再次點選即可取消靜音。

長按喇叭圖示可將該輸出設為單獨監聽（Solo），再次點選即可取消單獨監聽。

當有聲道被設為單獨監聽或靜音時，系統會顯示「清除所有單獨監聽（Clear　All 
Solo）」或「清除所有靜音（Clear　All　Mute）」按鈕。

點選此按鈕可取消所有單獨監聽或靜音，恢復全部聲道播放。



監聽頁面提供比主頁（Home Page）更完整的 監聽區域（Monitoring Section） 展
示。有關這些控制功能的概覽，請參考上方主頁章節的說明。

監聽頁面 -

　　全域控制

　校正檔選擇　　　　主要音量控制

群組靜音與單獨監聽



前/後處理控制

預設選擇為 PRE，顯示從 DAW 輸出進入 ORIA Control Desktop Software 的訊號。
POST則顯示經過喇叭校正處理後，從ORIA　Mini輸出的訊號。
在 POST 量測模式下，系統也會將主音量控制（Volume Control）納入考量。

量測頁面可對 ORIA Mini 的所有輸出電平進行高解析度監控。

量測頁面-

Meters

Pre/Post Control



校正檔選擇頁面是其他分頁中 校正檔選擇 區域的擴展版，除了可選擇目前的 啟用校正
檔（Active Profile） 外，也可選擇未被指定到四個常用欄位的其他校正檔。

校正檔選擇頁面 -



當您需要重新連接 ORIA Remote iPad App 至 ORIA Mini，或想更換目前連接的裝置
時，可使用此頁面進行操作。

連接頁面 -



iPad 名稱

可設定 iPad 在連接 ORIA Control Desktop Software 時所顯示的名稱。

App 顏色模式

可將 ORIA Remote iPad App 設定為 暗色模式（Dark Mode） 或 亮色模式（Light 
Mode），以適應您的錄音室環境。

也可設定為 系統預設（System Default），讓 App 自動跟隨 iPad 的全域設定。如果您
的 iPad 設定為依照一天中的時間自動切換深/淺色模式，此功能將非常實用。

　音量控制自動鎖定

App 顏色模式

設定 -



音量控制自動鎖定

此設定用來調整主音量控制（Main Volume Control） 的鎖定行為。

啟用自動鎖定（Autolock Enabled）：調整音量後，點選音量滑桿以外的任何區域，音
量設定會自動重新鎖定。

停用自動鎖定（Autolock Disabled）：調整音量後，音量控制會保持解鎖狀態，直到再
次點選音量控制以手動鎖定。



Stream Deck
ORIA Mini 的 Stream Deck 整合功能，讓您可使用任何 Stream Deck 系列裝置 遠端
控制大部分ORIA　Mini功能。這意味著您可以將 ORIA Mini 安裝在桌面上，同時在揚
聲器的最佳聆聽位置（sweet spot）輕鬆完整地控制監聽設定。

可在 Elgato Marketplace 免費下載

https://marketplace.elgato.com/product/oria-control-0d6d36b4-83d7-49a9-bc17-eaa6ee65b1e4
https://marketplace.elgato.com/product/oria-control-0d6d36b4-83d7-49a9-bc17-eaa6ee65b1e4


安裝

如果您使用的是 ORIA Control Desktop Software V1.3 或更新版本，ORIA Control 
Stream　Deck插件（Plugin）已包含在ORIA軟體安裝程式中。
當 ORIA Control Desktop Software 偵測到系統已安裝 Elgato Stream Deck 軟體時，會
提示您安裝 ORIA Control 插件。

若未自動提示，您也可以在 Elgato Stream Deck Marketplace 找到 ORIA Control 插
件。安裝方法如下：確認您已登入Elgato帳號。點選 「Get」，即可將 ORIA Control 插
件新增至 Elgato Stream Deck 軟體控制面板中。

校正檔（Profiles）

為快速設定，ORIA Control 插件內建所有常見 Stream Deck 裝置的預設 Profiles，會自
動將所需控制項載入到您的 Stream Deck 裝置，讓您立即開始與 ORIA Mini 配合使用。

當然，您也可以依需求 建立自訂 Profiles，相關操作會在下方 「Actions」 章節中進一
步說明。

重要說明:
由於 Stream Deck 軟體的運作方式，安裝 ORIA Control 插件 時，僅會安裝目前開
啟的Stream　Deck裝置對應的Profile。如果您想同時使用多個 Stream Deck 裝
置，可以從Elgato　Marketplace下載所需的Profiles：
https://marketplace.elgato.com/stream-deck/profiles

可用的 Stream Deck 裝置 Profiles

• Stream Deck MKII
• Stream Deck +
• Stream Deck XL
• Stream Deck Mini
• Stream Deck Neo
• Stream Deck Mobile



此操作可用來調整ORIA　Mini的輸出音量。

無旋鈕（Dial）控制的 Stream Deck：通常會有兩個音量按鈕，一個用於增加音量，另
一個用於降低音量。按一次即可調整一個單位，按住可快速進行較大幅度的音量調整。

Stream Deck +（具旋鈕）：音量操作也可指定給四個旋鈕之一。旋鈕可作為一般旋轉式
音量控制使用，同時也可按下旋鈕以 靜音/取消靜音（Mute/Unmute） ORIA Mini 的輸
出。

控制項（Controls）

音量

Output - 設定 Volume Action 要調整哪個輸出。

Step - 設定按鈕是增加音量還是降低音量。（在 Stream Deck + 的旋鈕模式下，此選項
不可用。）

操作
如果您想建立自訂 Profile，將 ORIA Mini 控制功能加入其中，可使用 ORIA Control 插件 
內提供的各種ORIA　Control　Actions。
以下為每個操作的簡要說明以及使用方式：



Output -  設定靜音操作所影響的輸出通道。

Output - 設定 DIM 功能要調整的輸出通道。 

靜音功能用於關閉或開啟 ORIA Mini 的輸出。

控制項（Controls）

DIM 功能會將 ORIA Mini 的輸出音量降低至預設值，非常適合在不需要暫停或靜音播放
的情況下，快速與藝人交談。

控制項（Controls）

靜音 -

Dim -



Action-
Step　Through：循環切換各個輸入來源。
Set To：指定按下按鈕時要選擇的輸入來源。

Step - 當 Action 選擇 Step Through 時，可設定控制是向前還是向後切換輸入來源。

Source - 當 Action 選擇 Set To 時，可設定按下按鈕時所選的輸入來源。

輸入來源此操作可選擇 ORIA Mini 目前使用的輸入來源（Line 或 S/PDIF）。

控制項（Controls）：

輸入來源  -

此操作會將 ORIA Mini 的立體聲輸出合成為單聲道訊號，方便您檢查混音的單聲道相容
性。

控制項：單聲道操作無額外控制選項。

單聲道 -

此操作會將左聲道的相位反向，然後將左右聲道混合在一起。這會抵消置中聲像的訊

號，使您能聽到混音中的 「側邊（Sides）」 部分。

控制項：相位操作無額外控制選項。

極性 -



Profile - 在此可選擇 此按鈕要指派的校正檔，僅限前四個「最愛（Favourite）」校
正檔。

Speakers - 在此可選擇 此按鈕要控制的喇叭輸出。

 Action - 可選擇 靜音（Cut / Mute） 或 單獨監聽（Solo） 功能。

此按鈕可用來選擇ORIA　Mini目前啟用的校正檔（Profile）。
請注意，ORIA Control Stream Deck 插件僅提供前四個「最愛（Favourite）」校正檔。
當某個校正檔被啟用時，按鈕會顯示 藍色漸層（Blue Gradient）。

控制項:

此操作可對 ORIA Mini 的特定喇叭輸出（左聲道 L、右聲道 R 或低音 SUB）進行 單獨監
聽（Solo） 或 靜音（Mute）。

控制項:

校正檔 -

喇叭 -



Group - 您可以在此設定 此按鈕要控制的喇叭群組（Speaker Group）。 

Action - 在 群組操作（Group Action） 中，可選擇 靜音（Cut / Mute） 或 單獨監聽

（Solo） 功能。

此操作可對 ORIA Mini 的兩個喇叭群組 立體聲（Stereo） 與 低音（Subs） 進行 單獨監
聽（Solo） 或 靜音（Mute）。

控制項:

群組 -



故障排除

按下操作按鈕時出現黃色警告

如果按鈕被按下時出現警告符號，表示 Stream Deck 無法與 ORIA Control 應用程式
通訊。首先確認 ORIA Control Desktop Software 已開啟。若未開啟，請從 
Applications資料夾或Start　Menu啟動。

若已開啟，請先關閉應用程式再重新開啟，讓 Stream Deck Control 軟體能重新建立
與 ORIA Mini 的通訊。

我的 Stream Deck 裝置 Profile 未安裝

Stream Deck Control 軟體僅會安裝 安裝當下連接且處於焦點的 Stream Deck 裝置 
Profile。例如，若您當時連接並開啟的是 Stream Deck +，安裝 ORIA Control 插件
時，僅會安裝 Stream Deck + 的 ORIA Control Profile。

若您更換 Stream Deck 或希望同時使用多個裝置，可直接從 Elgato Marketplace 下
載並安裝其他 ORIA Control Profiles，支援所有 Stream Deck 型號: 
https://marketplace.elgato.com/stream-deck/profiles

https://marketplace.elgato.com/stream-deck/profiles


技術規格

系統規格:
類比輸入通道（Analogue Input Channels）：2
類比輸出通道（Analogue Output Channels）：3
數位輸入通道（Digital Input Channels*）：2
系統取樣率（System Sample Rate）：96kHz
（數位輸入內建取樣率轉換）

*USB 不傳輸音訊：USB 僅用於供電與控制資料傳輸。

Line 輸出 (via 透過光纖輸入):
•最大輸出電平: +18dBu
•動態範圍 (A Weighted): 127dB
• THD+N (-1dBFS): -113dB/0.0002%
•頻率響應 (20Hz > FS/2*): ± 0.1dB
• Crosstalk (1kHz): <-123dB

*FS/2 of the incoming optical signal.

Line輸入到Lin 輸出:
•最大輸入電平: +18dBu
•動態範圍 (A Weighted): 122.5dB
• THD+N (-1dBFS): -105dB/0.0005%
•頻率響應 (20Hz - 40kHz): ± 0.2dB
• Crosstalk (1kHz): <-118dB

數位輸入:
•雙聲道S/PDIF: 44.1kHz to 96kHz

USB:
•連接類型: USB-C
•電源需求: 0.9A @ 5V >=USB 3.0 Port
•內附線材: USB-C - 1m



Sonarworks 測量麥克風技
術規格

麥克風類型（Microphone Type）：電容式駐極體

換能器類型（Transducer Type）：MEMS

頻率響應（Frequency Response）：20Hz - 20kHz

指向性（Polar Pattern）：全指向（Omni-directional）

輸出阻抗（Output Impedance）：330Ω

靈敏度（Sensitivity）：-40dBV/Pa

訊噪比（SNR）：65dBA

動態範圍（Dynamic Range）：105dB

最大聲壓（Max SPL）：125dBSPL

電源需求（Power Requirements）：+48V 幻象電源（Phantom 

Power）

連接器類型（Connector Type）：3 Pin XLR

重量（Weight）：54g



閱讀說明（Read Instructions）：在操作本產品前，應先閱讀所有安全與操作說
明。

保留說明（Retain Instructions）：安全與操作說明應妥善保存以便日後參考。

遵守警告（Heed Warnings）：應遵守產品及操作說明中的所有警告。

遵循指示（Follow Instructions）：應遵循所有操作與使用指示。

清潔（Cleaning）：清潔前請先拔掉產品電源插頭。禁止使用液體清潔劑或噴霧清
潔劑，請使用乾布清潔。

附件（Attachments）：不要使用非產品製造商推薦的附件，避免造成危險。

水與濕氣（Water and Moisture）：請勿在靠近水源處使用本產品，例如浴缸、洗
手台、廚房水槽、洗衣槽、潮濕地下室或游泳池附近等。

配件與安置（Accessories）：請勿將本產品放置在不穩定的推車、支架、三腳
架、掛架或桌面上，以免產品跌落造成兒童或成人受傷及產品損壞。任何安裝應遵
循製造商指示，並使用製造商推薦的安裝配件。

火源（Flame Sources）：請勿將明火（如點燃的蠟燭）置於產品上方。

安全資訊

Tel: 0044 1256 381944 安

重要安全指示



保固資訊

保固聲明

您的 ORIA Mini 自寄送給最終使用者之日起，享有 三年（36 個月）製造商保固。保固範
圍僅涵蓋因製造材料缺陷或工藝瑕疵所導致的故障。在保固期間，Audient 將提供維修或
自行判斷後更換故障裝置，但前提是產品須以付運費方式送至 Audient 授權服務中心。

若故障原因被認為是由未授權修改、誤用、疏忽或意外導致，將不提供保固維

修。Audient 僅承擔如上所述的維修或更換責任，不承擔任何額外責任。本保固不影響您
對於產品供應商依法享有的任何權利——本保固為對原有權利的補充。

保固限制

本保固不涵蓋因意外或誤用所造成的損壞。

若維修非由授權服務中心進行，保固將失效。

若產品已被修改且非依製造商指示操作，保固將失效。

本保固不涵蓋有限壽命的零組件，這些零組件需定期更換以維持最佳效能。

本公司不保證產品運作方式會超出本手冊所描述的範圍。






